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Overview and New Features
This Dentrix G6 Canada Release Guide provides information about the new software release. This 
overview section includes important notes regarding this release, followed by a brief description of the 
new features and enhancements available in this release.

Note: For information about using the new features in this release, refer to “Using the New Features and 
Enhancements” in this document or “What’s New in Dentrix?” in the Dentrix Help. 

Important Notes
•	 With the release of Dentrix G6 Canada, the Dentrix database location has been moved to  

<Drive Letter>:\Dentrix\Common. If you are upgrading from a previous version, your current backup 
configuration will no longer be valid and you will need to re-configure your backup software to back 
up the new location of the Dentrix database files. If you are using eBackUp, please contact eServices 
Customer Support at 1-800-734-5561 for assistance. If you use a third-party backup product, please 
contact a qualified integration specialist.

•	 Beginning with Dentrix G6 Canada, Henry Schein Practice Solutions no longer develops solutions 
for or tests compatibility with Windows 2000. Dentrix G6 will not install on Windows 2000 or prior 
Windows operating systems.

•	 Visit www.dentrix.com/products/dentrix to download an updated copy of the Dentrix G6 Canada 
system requirements.

•	 Henry Schein Practice Solutions recommends that you install this update at a time that is outside your 
regular office hours.

•	 The Dentrix G6 database allows backups using the eBackUp product to occur while Dentrix modules 
are open. If you are using any backup product other that eBackUp, you must close all Dentrix 
modules before backing up your Dentrix database. Failure to do so could result in data errors.

•	 Beginning with Dentrix G6 Canada, Guru Limited Edition is no longer installed with Dentrix; 
however, Dentrix integration with existing installations of Guru Limited Edition is still supported. For 
information on using Guru Limited Edition, refer to the Dentrix Help.

New Features
Dentrix G6 Canada includes the following new features and enhancements:

ALERTS

•	 Medical alerts were enhanced so you can save medical alert notes in the notes history. You can copy 
medical alert notes to clicnical notes, include medical alert notes in the Patient Notes Report, and 
add patient notes from Questionnaire forms to the medical alert note.

•	 In the Create Patient Alert dialog box, a new “Questionnaires” option was added to the list of 
options where a patient alert could be displayed in Dentrix.

APPOINTMENT BOOK

•	 Clicking an appointment outlines the appointment block in black so that it’s easier to see. Also, 
clicking an appointment block highlights the appointment time in yellow in the time bars. If you 
hover the mouse pointer over a time block, the time appears in the block. Tooltips were added to the 
provider columns, so you can tell at a glance which color is assigned to which provider. You also have 
the option of hiding the provider color columns from the Appointment Book view.

•	 The Enter New Patient Information dialog box was modified to include text boxes for a mobile 
phone number and an e-mail address. These changes appear in the More Information dialog box, the 
Hover window, and Route Slips and Patient View Forms.
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•	 The order of the checks and message prompts that appear when you are scheduling appointments 
has been changed to be more logical.

•	 The following options were added to the Select View and the Print Appointment Book View dialog 
boxes: Mobile Phone, Other Phone, Email, Age, Birthdate, Primary Insurance, Guarantor Name, Appt 
Status, and CC Attached.

•	 When you schedule appointments, conflict warning messages no longer appear excessively.

•	 Now, when you purge appointments, you can also purge appointment history and events.

•	 When you create an appointment, you can now type a specific appointment length.

•	 You can now specify an additional Provider ID for an appointment. You can also display this additional 
Provider ID field in the appointment block, Hover window, the Print Appointment Book View Report, 
the Patient Route Slip, and the Patient Visit Form.

•	 The Set Appointment Procedures Complete dialog box in the Appointment Book now allows you to 
view and easily assign providers to procedures before posting them.

•	 Appointment blocks, the Hover window, the Appointment Information dialog box, and the 
Appointment History dialog box now include a Date/Time Created field and Staff ID field so you can 
see when the appointment was created and who created it.

DOCUMENT CENTER

•	 A new screen capture feature allows you to select an area of the screen and save the image in the 
Document Center. To learn more, see “Acquiring screen captures” in the Dentrix Help.

•	 Acquiring documents for the Document Center is even easier now. You can acquire documents using 
any type of device that supports the following outputs: .pdf, .doc, .docx, .xls, .ppt, .bmp, .gif, .jpg, 
.png, .txt, and .rtf. Scanners no longer have to be WIA or TWAIN compliant. Further, you can now 
designate a folder that you can save images and documents to automatically regardless of the type 
of device you used to scan the image or document. If you want, you can disable the Auto Acquire 
feature.

•	 You can now rename Document Type Category names if they are attached to a signed document.

•	 The Document now notifies you when there are more than 40 unfiled documents.

LEDGER

•	 Several enhancements were made to the Ledger including new columns (entry date, surfaces, check 
#), adjustable column widths that are automatically saved when you close the Ledger, the ability to 
sort by and hide columns, a note indicator for payments and adjustments that have a note, tooltips 
for the column headings, alternate row shading, and a Refresh button on the toolbar.

•	 When clicking Enter Batch Payments from the File menu, a new Batch Payment Entry dialog box 
appears with enhanced functionality.

•	 You can now split payments by multiple family members.

•	 When you click the Statement Notes button, a more detailed message now appears if you have 
exceeded the number of characters allowed in the Billing Statement Notes text box.

•	 The wording of the Check # field in the Enter Payment dialog box was changed to Check/Payment #.

•	 If you have not selected Assignment of Benefits for a patient, you can now set an option in the 
Insurance Payment Setup dialog box to prompt users to post a $0 payment when the claim is created 
and close the pending claim.

•	 If a claim has not been created for today’s procedures, the estimates in the transaction log appear in 
red. A tooltip reminds office personnel to create a claim.

•	 In the Ledger Colors Setup dialog box, a new Restore Defaults button was added so you can restore 
the default Ledger colors.
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•	 You can now close pending claims for a selected patient or for all patients who must bill their 
insurance carriers themselves rather than assign their benefits to their providers. Previously, these 
types of claims would remain outstanding until providers claosed them manually by posting a $0.00 
payment to the claim.

•	 A new Year End Recommendations option was added to the Ledger’s Month End menu. This option 
opens a PDF document with year-end recommendations from Dentrix Customer Support. 

FAMILY FILE

•	 You can no longer archive a patient who has a credit balance.

•	 The Select Medical Alert dialog box now has an Insert Dateline button, so that you can insert a date 
in the Note text box.

•	 The Medical Alerts dialog box user interface has been improved.

LETTERS/LIST MANAGER

•	 You can use a new List Manager tool (similar to the one in Collections Manager and Treatment 
Manager) to create, view, and print customized lists of patient information. The List Manager also 
allows you to “hide” patients and merge letters for only the listed patients.

•	 The Letter Merge feature includes a new option that allows you to open a data file in Microsoft Excel 
or Notepad.

•	 The Patient Report View dialog box associated with the Office Manager’s Letters feature was 
redesigned to list all the available data fields in a single tree view. A new Select All option was added 
so you can select all data fields at once. A new Email option in this dialog box allows you to specify 
whether you want to include patients With Email addresses, Without Email addresses, or All.

•	 A new data field was added where you can specify the date a patient last referred another patient.

•	 The process of generating letters and lists is now simpler and requires fewer mouse clicks. It is more 
flexible when using data files and creating journal entries.

OFFICE MANAGER

•	 In the Daily Huddle Report dialog box, you can use a new drop-down menu to specify whether you 
want to print/batch the Patient Visit Form or the Patient Route Slip.

•	 The Source of Payment list box in the Dental Insurance Plan Information dialog box includes several 
new options that you can select.

•	 You can now sort the Patient List Report by family by family (guarantor and dependents).

•	 If opened from the Office Manager and if passwords are enabled, the Office Journal defaults to the 
staff member logged into Dentrix.

•	 Peachtree 2000 was removed from the Export To list in the DXPort Setup dialog box.

•	 Monitoring when someone previews or prints Day Sheet and Audit Trail reports is easier now. Each 
type of report has its own record in the Dentrix database and its own series of sequential audit 
numbers so that you can track each report type individually. Dentrix stores the last audit number 
used for each report and increments it the next time someone previews or prints a report. The audit 
number prints in the lower left corner of each report. Each time someone previews or prints a report 
the audit trail entry now includes the type of report, the audit number, and the date and time stamps 
of the report. If you have enabled passwords, the audit trail also includes the user name. Knowing 
who previewed or printed what type of report and when can make it easier for you to identify possible 
instances of fraud in your office.

•	 Switching in and out of the Tutor database is much easier than before. After you switch out of the 
Tutor database, Dentrix automatically reconnects to your practice’s live database.

•	 For insurance payments made for multiple patients or more than one patient in a family, you can list 
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each patient and the amount paid per patient below the cheque that appears on the Deposit Slip 
Report and the Daily Collections Report.

•	 You can now add Clinical Notes to the Patient Notes Report.

•	 You can now set up and maintain fee schedules from one place. You can edit fee schedules manually, 
and you can export fee schedules to a Microsoft Excel spreadsheet as a comma delimited (.csv) file.     

PERIO CHART

•	 When you close a month, perio exams are now moved to History so that they can be protected. Once 
a perio exam is moved to History, it cannot be edited.

PRESCRIPTIONS

•	 To satisfy the requirements of the Narcotics Safety and Awareness Act, the Prescriptions module now 
allows providers to record and display patient identification types and their corresponding numbers 
(driver’s licence, health card, passport, and so on). The Act also allows the Ministry of Health and 
Long-Term Care to track the prescribing and dispensing of all monitored drugs. To learn more about 
setting a patient’s identification type, see “Setting up prescription IDs” in the Dentrix Help.

PATIENT CHART

•	 The Patient Chart has an enhanced “Refresh” feature that reloads any changes made to setup 
configurations, such as added/edited procedure codes, multi-codes, provider information, medical 
cross-coding, clinical note templates, and so forth. You can now refresh these settings without closing 
and re-opening the Patient Chart.

MISCELLANEOUS 
•	 Dentrix G6 Canada now uses a true client-server database architecture. This architecture adds 

additional stability and efficiency to the software because the server rather than the workstations now 
performs the work of retrieving and writing data to and from the database.

•	 Dentrix G6 Canada now supports ClaimStream, an Internet-based eclaims service, in addition to 
ITRANS. Through ClaimStream, you can submit claims directly to Alberta Blue Cross, Medavie Blue 
Cross, and Pacific Blue Cross via the Internet.

•	 The enhanced Select Patient dialog box introduced in Dentrix G2 is now the default for all Dentrix 
modules from which you can select a patient. If you want to use the simple Select Patient dialog 
box instead, you must select Use Simple Select Patient in all Modules in Preferences in the Office 
Manager.

•	 You can now create a DDX lab case from the Chart, the Treatment Planner, or the Appointment Book. 
You can also use any lab with DDX. You must register DDX before using it. Registration is free. 

•	 Receiving updates to your Dentrix products and add-on features has been streamlined. If you are on 
an active customer service plan, you can receive updates automatically without interruption to your 
workday through the Dentrix Update Manager.

•	 Support for Webcam DirectShow has been added to Dentrix to support USB image acquisition 
devices such as cameras.

•	 When you first open Dentrix, a “What’s New” message appears listing the new features added to 
Dentrix.

•	 Your Customer ID now appears in the About Dentrix dialog box.

•	 Processes, such as Month End, utilities, and the Month End Wizard, that require all Dentrix modules 
to be closed now display a list of all workstations with active modules and the names of the modules.
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•	 The Dentrix logo has been updated and appears in the About Dentrix dialog box.

•	 Dentrix now includes a contact manager called eDex that lets you manage and quickly search for 
Dentrix contacts, such as patients, providers, staff, labs, insurance carriers, and other contacts. You 
can search by first or last name, address, email address, or phone number. You can also add custom 
notes or append notes to a patient note. A button to access eDex was added to the toolbars of most 
Dentrix modules; a button and graphic was also added to the Dentrix Launcher.

•	 The toolbar buttons for all modules were given a newer look. The images below illustrate the changes 
in the Office Manager toolbar from Dentrix G4 to Dentrix G6 respectively.

•	 The Dentrix Launcher icon was modified.

•	 A Click to Chat button was added to all of the Help menus in the main modules.

•	 The Spell Checker software was updated.

Installing Dentrix G6 Canada
You must install Dentrix G6 Canada on each computer that runs Dentrix.

Complete the following steps to install Dentrix G6 Canada. 

1.	 If you are upgrading to Dentrix G6 Canada from Dentrix 11.0, G2, or G3, you must first install Dentrix 
G4 Canada. Your Dentrix G6 Canada installation kit includes software to upgrade to Dentrix G4 
Canada on the Dentrix G6 Canada installation DVD. Instructions for installing Dentrix G6 Canada are 
available in the Dentrix G6 Canada Installation Guide in the installation kit and also available in the 
Dentrix Resource Center (www.dentrix.com/resource-center/).

2.	 Follow the on-screen instructions to install Dentrix G6 Canada.

For help with the download and installation of Dentrix G6 Canada, please refer to the Dentrix G6 
Installation Guide or contact Dentrix Customer Support at 1-800-DENTRIX.

Installing Dentrix G6 Canada on Other Computers
Unlike previous versions of Dentrix, you must install Dentrix G6 Canada on the server first. If you attempt 
a server installation on any other computer on your network, that computer will become your server. Once 
you install the software on one computer on your network, you can easily install it on any other computer 
on your network when you open any Dentrix module.
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Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release.

Ledger
The Ledger includes several enhancements including new columns (entry date, surfaces, check #), 
adjustable column widths that are automatically saved when you close the Ledger, the ability to sort 
by and hide columns, a note indicator for payments and adjustments that have a note, tooltips for the 
column headings, alternate row shading, and a Refresh button on the toolbar. 

SPLITTING PAYMENTS BY MULTIPLE FAMILY MEMBERS

You can split payments by multiple family members.

To split a payment by multiple family members

1.	 From the File menu in the Ledger, click Enter Batch Payments.

The Batch Payment Entry dialog box appears.

2.	 Click the Patient Name search button, and then select the appropriate patient from the Select 
Patient dialog box.

The Enter Payment dialog box appears.
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3.	 Do the following:

•	 Date – (Optional) Type a date to change the procedure date from the current date.

•	 Payment Types – Select the appropriate type from the list.

•	 Amount – Type the payment amount in dollars.

•	 Cheque Number – Type the number, if applicable.

•	 Bank/Branch # – Type the number if you want it to appear on the Dentrix Deposit Slip.

•	 Provider – (Optional) Select a provider from the list. (Default is to split the payment by provider.)

•	 Patient – Select Split By Family Members. (Default is to apply the payment to the selected patient 
in the Ledger.)

•	 Split Method – Select one of the following options:

•	 Percentage Payments – Divides the payment among the providers according to each 
provider’s percentage of the total amount owed.

•	 Guarantor Estimate – (Default) Applies the payment to providers who have balances as 
guarantor estimates and ignores provider balances that Dentrix estimates insurance will pay 
the remainder of.

•	 FIFO (First In First Out) – Applies the payment toward the oldest completed procedures first.

•	 Equal Payments – Splits payment amounts equally among all providers with debit balances.

•	 Details – Click to view payment details.

•	 Note – Type a note to document any unusual circumstances related to the payment.

•	 Apply To Payment Agreement – (Selected automatically if the account has a payment 
agreement.) Clear the option if the payment should not be applied to the payment agreement.

4.	 Click OK.

CLOSING NON-ASSIGNMENT OF BENEFIT PENDING CLAIMS AUTOMATICALLY

A new feature allows you to automatically close pending insurance claims for those patients who are 
responsible for billing their insurance carriers.

To close a non-assignment of benefit pending claim automatically

1.	 From the File menu in the Ledger, click Non-Assignment Pending Insurance Claims.

The Non-Assignment Pending Insurance Claims dialog box appears.
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2.	 Under Pending Claims, select one of the following:

•	 Select Patient’s Family – Select to close any outstanding claims for the current patient in the 
Ledger. To select a different patient, click the search button and select the appropriate patient 
from the Select Patient dialog box.

•	 All Patients – Select to close all outstanding non-assignment of benefits claims for all or selected 
patients. A message box appears stating that the list may take several minutes to generate 
depending on the size of your database. Click Yes to continue.

3.	 Do one of the following:

•	 Click Select All to close all the claims in the list.

•	 Click the claims that you want to close.

4.	 Click Mark Selected Claims as Received.

A message box appears stating that the selected insurance claims will be marked as “Received.”

5.	 Click Yes to continue.

Dentrix posts the selected claims to the Ledger with a $0.00 dollar payment.

eDex
eDex is an electronic contact manager and directory to which you can attach patient notes. You can use 
eDex to manage and quickly search lists of patients (active, inactive, or archived), employers, insurance 
carriers, labs, non-patients, providers, staff, referrals, and any other contact you may want to remember. 
Using eDex, you can create custom contacts and contact categories to filter the Contacts List or even 
locate a patient’s next appointment.

To open eDex and add a contact

1.	 In the toolbar of any Dentrix module, click the eDex button.

The eDex window appears.

2.	 In the eDex toolbar, click the New Contact button.
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The Add New Contact dialog box appears.

3.	 Do one of the following:

•	 Category – Click the arrow and select a category from the list.

•	 Category Setup – Click the button and add a category.

4.	 Type the following Contact Information:

•	 Contact Name – (Since Dentrix alphabetizes the patient list according to patients’ surnames, 
consider entering the contact’s surname followed by the contact’s given names when you are 
adding personal contacts.)

•	 Company Name

•	 Email Address

5.	 Type the following Address Info:

•	 Street 1

•	 Street 2 (if necessary)

•	 City –

•	 PV

•	 PC

6.	 Type the following Phone Info:

•	 Preferred

•	 Work

•	 Fax

•	 Mobile

7.	 Click Save.

List Manager
You can use the new List Manager (similar to tools in the Collections Manager and the Treatment 
Manager) to create, view, and print customized lists of patient information. Using the List Manager you 
can also “hide” patients and merge letters for only the listed patients.

To create a letter using the List Manager

1.	 In the Office Manager menu, click Letters & Custom Lists.
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The Letters & Lists dialog box appears.

2.	 Click the button, such as Birthday, corresponding to the type of letter that you want to create.

A dialog box corresponding to the type of letter appears.

3.	 From the list, select the letter that you want to create, and then click Open List Manager.

The List Manager window appears.

4.	 In the toolbar, click the Create Letters button.

A message box appears.

5.	  Click Yes.

Dentrix opens Microsoft Word and creates a letter for every patient listed in the List Manager.
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Document Center
New features of the Document Center include being able to acquire documents using any device that 
supports the following outputs: .pdf, .doc, .docx, .xls, .ppt, .bmp, .gif, .jpg, .png, .txt, and .rtf. You can 
also save documents automatically to a folder that you designate. In addition, you can use the new screen 
capture feature to select and capture an area of your computer screen and save the resulting image to 
the Document Center.

ACQUIRING DOCUMENTS AUTOMATICALLY

Acquiring documents for the Document Center is even easier now. You can acquire documents using any 
type of device that supports the following outputs: .pdf, .doc, .docx, .xls, .ppt, .bmp, .gif, .jpg, .png, .txt, 
and .rtf. Scanners no longer have to be WIA or TWAIN compliant. Further, you can now designate a folder 
that you can save images and documents to automatically regardless of the type of device you used to 
scan the image or document.

To set up auto file acquire

1.	 From the Acquire menu in the Document Center, click Auto Directory File Acquire.

The Setup Acquisition Method Defaults dialog box appears.

2.	 Use the following options to set up auto file acquire:

•	 Document Type – Select the appropriate type from the list.

•	 Description – Type a description of the document.

•	 Orientation – Select an orientation from the list. (Applies to X-rays and other images of a patient’s 
mouth.)

•	 Acquiring without displaying Document Information – Select to prevent the Document 
Information dialog box from appearing.

3.	 Under Set Default Scanner Import Folder, click the search button.

The Browse For Folder dialog box appears.
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4.	 Do one of the following, and then click OK:

•	 Select a folder.

•	 Click Make New Folder.

5.	 From the Setup Acquisition Method Defaults dialog box, do the following:

•	 Combine Images Created within X seconds – Select the appropriate number of seconds you 
want to pass before Dentrix combines several images that you acquired simultaneously into a 
single document.

•	 Click Save and Close.

ACQUIRING SCREEN CAPTURES

You can use the new Screen Capture feature to select an area of your computer screen and capture and 
save the resulting image to the Document Center.

To acquire a screen capture

1.	 From the Acquire menu in the Document Center, click Screen Capture.

2.	 To set up the default settings for screen captures, click Setup Defaults.

The Setup Acquisition Method Defaults dialog box appears.

a.	 Under Select Acquisition Method, select Screen Capture.

b.	 Select a document type from the list.

c.	 Select an orientation from the list, and click Save and Close.

3.	 To capture a screen, click Start Capture.

4.	 Position your mouse pointer where you want to start the capture and drag to capture the image.
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When you release the mouse button, the Document Center opens, and the image you captured 
appears in it.

Appointment Book
From the Appointment Book, you can set procedures complete, post them to the Ledger, and set the 
patient’s next Continuing Care appointment. If necessary, you can now also set procedures complete and 
post them to the Ledger for more than one provider at a time.

To set appointment procedures complete for an additional provider

1.	 In the Appointment Book, select the appointment that you want to set procedures complete for.

2.	 From the Options menu, click Post/Set Complete.

The Set Appointment Procedures Complete dialog box appears.

3.	 Select the procedure that you want to set complete for the additional provider, and then click Change 
Provider.

4.	 Select the additional provider from the sub-menu.

5.	 Click Post/Set Complete.

PROVIDER COLUMNS

You can now hide the provider columns from your view of the Appointment Book.

To hide the provider columns

1.	 In the Appointment Book menu, click View.

2.	 From the Select View dialog box, click New.

The Select View dialog box appears.
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3.	 Clear the View Provider Columns check box, and then click OK.

Medical Alerts
You can now save medical alert notes in the notes history. You can also copy medical alert notes to clinical 
notes, include medical alert notes in the Patient Notes Report, and add patient notes from Questionnaire 
forms to the medical alert note.

To copy a medical alert note to clicnical notes

1.	 In the Family File, select a patient.

2.	 Click the icon in the Medical Alerts block.

The Medical Alerts dialog box appears.

3.	 Click Edit.

The Select Medical Alerts dialog box appears.
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4.	 To add a note, type it in the Notes text box, and then click OK.

5.	 To copy the patient’s medical alert and any notes to the patient’s clinical notes, click Copy to Clinical.

6.	 Click OK to save your changes, and then click Close.

Prescriptions
The Narcotics Safety and Awareness Act requires all prescribers to record information, such as the 
following, when prescribing a monitored drug. The list below is not comprehensive:

•	 Driver’s licence

•	 Health card

•	 Passport–Canadian or other

•	 Provincial or territorial birth certificate

•	 Certificate of Indian status

Setting up prescription IDs

1.	 From the toolbar of any Dentrix module other than the Office Manager, click the Prescriptions button.

The Patient Prescriptions dialog box appears.

2.	 Click Prescription Identification Setup.

The Prescription Identification Setup dialog box appears.

3.	 Do one of the following:

•	 Select Use Driver’s License #, and then click OK.

•	 Select the appropriate type from the Identification Type list, type the identification number 
corresponding to the patient’s identification type in the Identification Number text box, and then 
click OK.

Patient Chart
The Patient Chart has an enhanced “Refresh” feature that reloads any changes made to setup 
configurations, such as added/edited procedure codes, multi-codes, provider information, medical cross-
coding, Clinical Note templates, and so forth. You can now refresh these settings without closing and 
re-opening the Patient Chart.
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Office Manager

SWITCHING DATABASES

Switching out of the “Tutor” database back to your live database is much easier than before. When you 
close all Dentrix modules when you are in the “Tutor” database, Dentrix  automatically reconnects to your 
practice’s live database.

To switch databases

1.	 From the Maintenance menu in the Office Manager, point to Practice Setup, and click Preferences.

2.	 From the Preferences dialog box, click the Paths tab, select Switch to Sample Database, and then 
click OK. 

DEPOSIT SLIP AND DAILY COLLECTIONS REPORTS

Often insurance companies send a single cheque to pay for multiple procedures for multiple patients. 
After entering insurance payments in the Ledger or the Batch Insurance Payment Entry dialog box, you 
can now create a Deposit Slip or a Daily Collections report that lists each patient and the amount paid 
per patient below each cheque entry.

To create a Deposit Slip Report

1.	 From the Reports menu in the Office Manager, point to Management, and click Day Sheet.

The Day Sheet dialog box appears.

2.	 To print cheque details on deposit slips, select Deposit Slip, and then click Options.

The Options dialog box appears.
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3.	 Select Include Check Detail and click OK.

To create a Daily Collections Report

1.	 From the Reports menu in the Office Manager, point to Management, and click Day Sheet.

The Day Sheet dialog box appears.

2.	 To print cheque and/or payment adjustment details on the Daily Collections Report, select Daily 
Collections, and then click Options.

The Options dialog box appears.

3.	 Select Include Check Detail and click OK.

Fee Schedules
You can now set up and maintain fee schedules from one place. You can edit fee schedules manually, and 
you can export fee schedules to a Microsoft Excel spreadsheet as a comma delimited (.csv) file. For more 
information, see Fee Schedules in the Dentrix Help.

To set up a fee schedule

1.	 From the Maintenance menu in the Office Manager, point to Reference, and then click Fee Schedule 
Maintenance.
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The Fee Schedule Maintenance dialog box appears.

2.	 Click New.

The New Fee Schedule dialog box appears.

3.	 Type a fee schedule name in the appropriate text box.

Note: We recommend that you add your practice’s usual and customary fees to Fee Schedule #1. 
Fees are not pre-assigned in Dentrix.

4.	 Under New Fee Schedule Options, do one of the following:

•	 Start with Blank Fee Schedule – Select to use a blank fee schedule.

•	 Copy From Fee Schedule – Select and then from the list, select the fee schedule that you want to 
copy.

•	 Import From File – Select to import the fee schedule from a comma delimited (.csv) or Excel file. 
Select the appropriate file from the Select file to import dialog box.

5.	 Under New Fee Schedule Position, do one of the following:

•	 Use Next Blank Fee Schedule – Select to use the next blank position in the fee schedule list.

•	 Select Fee Schedule Position – Select and then from the fee schedule list, select where you want 
the new fee schedule to be positioned.

6.	 Click OK.

The View/Edit Fee Schedule dialog box appears.

7.	 Click Save.
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DDX Desktop
DDX (Digital Dental Exchange) integrates with Dentrix through the DDX Desktop program, which is 
installed during the Dentrix installation. You can access DDX Desktop not only from Dentrix but also 
by itself from the Windows desktop icon or Start button (from the Start button, click All Programs, DDX 
Desktop, and then DDX Desktop).

You can create DDX lab cases from the Patient Chart, the Treatment Planner, and the Appointment Book. 
You can also update lab case status, pass patient and appointment details from Dentrix to DDX, pass 
CDT codes for a current case from Dentrix to DDX, make a list of future appointments in Dentrix for a 
selected patient available to DDX, and attach a Document Center file or image to a DDX lab case.

Note: You must already have or need to sign up for a free DDX account to use DDX Desktop.

Setting up DDX Desktop for first time use

1.	 Open DDX Desktop by double-clicking the shortcut icon on the desktop.

The DDX Desktop window opens, and a welcome message appears.

2.	 Click Setup.

The Login page opens.

3.	 Log in to your DDX account.

For information about how to log in, see “Logging in to your account” in the DDX Help.

The Register Remote Application page opens.

4.	 To allow DDX Desktop to access your DDX account, click I Approve.

A message appears.

5.	 To integrate Dentrix with DDX Desktop, click OK.

6.	 Close all Dentrix modules on all computers, and then click Yes to confirm that you want to update the 
files that control the integration of Dentrix and DDX Desktop.

7.	 Click Yes to confirm that you want to grant DDX Desktop access to your Dentrix data.

A progress indicator appears.
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When the update is complete, the portal page of your DDX account opens.

Dentrix G6 Canada Software Changes and 
Fixes
Dentrix G6 contains the following software changes and fixes:

Appointment Book
•	 If you selected the Do Not Bill to Dental Insurance option for a head of household and then set 

an appointment complete for a member of the household who has his or her own insurance, the 
procedures are not billed. This has been fixed.

•	 Clearing a procedure in the Set Appointment Procedures Complete dialog box did not prevent the 
procedure from being set complete. This has been fixed.

•	 The first digit in any field in the Account Guarantor text box of the Patient Visit Form was cut off if the 
patient had a large credit balance. This has been fixed. Completing a continuing care appointment 
did not advance days. This has been fixed.

•	 Clicking the Other Appts button goes to the day of the future appointment but does not highlight 
the appointment. This has been fixed. Archiving a patient does not remove the patient from the 
Unscheduled List. This has been fixed. The preview for the Hover Detail Setup dialog box now looks 
like the actual Hover window. Breaking an appointment changes the appointment’s creation date. 
This has been fixed. The Scheduled Patients Summary Report listed patients as having no future 
appointment even though they had appointments scheduled. This has been fixed.

•	 When selecting treatment plan procedures for an appointment, the procedures are now grouped by 
treatment plan case.

•	 If an appointment for an archived patient was selected when you opened the Ledger from the 
Appointment Book, an error message appeared. This has been fixed, and the error no longer 
appears.

•	 When editing continuing care in the Family File, if you set the Total Time Units in the Appointment 
Time Pattern dialog box to a value greater than 17, Dentrix would not use that default time value 
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when scheduling a continuing care appointment in the Appointment Book. This has been fixed.

•	 After an appointment in the Appointment Book was set complete and you created a new 
continuing care appointment for the patient with certain settings (Allow Amount to be entered/
fixed was selected and Always Calculate was not selected), the Amount shown in the Appointment 
Information dialog box was not correct. This has been fixed.

•	 If you pressed an unassigned shortcut key (such as F5) when using the Appointment Book, the 
production amount (if displayed) would disappear in the top right corner of the Appointment Book.
This has been fixed.

•	 When an appointment that included two procedures set to all chair time (_) was created, the time 
intervals would be changed to all provider time (X). This has been fixed.

•	 If you clicked Find in the Appointment Information dialog box to look for a new appointment time, 
the Find New Appointment Time dialog box did not remember the provider and operatory defaults 
from the original appointment. This has been fixed.

•	 The month view in the Appointment Book did not display the office’s closed hours or days. This has 
been fixed.

•	 The Appointment Book allowed you to set complete future appointments. This is no longer allowed.

•	 The Appointment Book New Patient status did not automatically update when a new patient was 
added to a family using a different workstation than the one where the new patient appointment was 
added. This has been fixed.

•	 After changing the date on a Flip Tab in the Appointment Book, clicking the Flip Tab didn’t take you 
to the new date. This has been fixed.

•	 When creating a new continuing care appointment and posting a multi-code, the reason for the 
appointment did not update using the description for the multi-code but was instead left blank. This 
has been fixed.

•	 Purged appointments now appear in the Audit Trail Report.

•	 If the Allow Amount to be entered/fixed option was selected in the Appointment Book, the correct 
dollar amount did not appear when creating the next continuing care appointment. This has been 
fixed.

•	 When printing an Appointment Book view that included a linked event, the wrong icon (+) was used 
for the event. The correct “link” icon is now used.

•	 When viewing the Hover Window for a patient with a patient picture, the Appointment Book would 
stop responding if the patient picture was unavailable (due to the patient picture file being deleted, 
moved, corrupted, and so on.). This has been fixed.

•	 The Patient Visit Form would list future appointments in the order they were created, not in 
chronological order. The form now lists them in chronological order.

•	 Some customers would see the message “Operatory is already scheduled for requested time” 
when there was no visible appointment scheduled during the time they were trying to schedule the 
appointment. This has been fixed.

•	 When scheduling an appointment for a patient who had more than 26 treatment case visits 
scheduled, any treatment case visits over 26 would be numbered using letters of the alphabet (A, B, 
C, and so on.). Numbers are now used.

•	 The appointment history in the Appointment Book (and Appointment History List in the Office 
Manager) did not update with changes made after an appointment was completed. This has been 
fixed.

•	 Creating a Day Note for the same day from two different Dentrix computers would cause the 
following message to appear when trying to save it on the second computer: “Another note was 
recently added for this claim at another workstation. This note cannot be saved.” Now a lock is 
placed on the Day Note message while it is open on one computer; if another Dentrix user tries to 
open and edit the Day Note, a message tells the other user that the Day Note is open on another 
computer.
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•	 The More Information (Dial) menu item on the File menu is no longer enabled when an event is 
selected in the Appointment Book.

•	 When eight or more operatories were displayed in the Appointment Book, and the View Time at 
Right option was selected in the Practice Appointment Setup, some of the time digits could overlap, 
causing 11:00 to appear as 1:00, for example. This has been fixed.

•	 In the Provider Setup dialog box, you can now only assign up to twelve time blocks to a single 
operatory.

•	 If a time block was manually moved to a new time and the time block series was subsequently 
deleted, the Appointment Book would not show the time block but continued to respond as if it was 
there when scheduling appointments (a message about a time block would appear when scheduling 
appointments during that time). This has been fixed, and the message no longer appears.

•	 When a lock was placed on a practice resource (perhaps because it was being edited in the Resource 
Setup by another user), if a user tried to edit an appointment in that operatory, the message “Practice 
resource file open at another workstation” would appear, followed by “Invalid operatory ID.” These 
messages no longer appear.

•	 When dragging an appointment in the Appointment Book, if you pressed Alt+Tab to leave the 
Appointment Book and then released the mouse button, the appointment would be “stuck” to the 
mouse insertion point, causing several display issues in the Appointment Book. This has been fixed.

•	 If an operatory was deleted, it still appeared as the default operatory selection in the Appointment 
Book’s Appointment Information dialog box. This has been fixed.

•	 Appointment history now tracks new continuing care appointments that are moved from the 
Pinboard.

•	 If you closed the Appointment Book while a Continuing Care List was generating, a “global lock” 
error would appear. Dentrix now prevents you from closing out of the Appointment Book while the 
Continuing Care List is generating.

•	 The Continuing Care Attached field and Patient Pending Continuing Care dialog box in the 
Appointment Information dialog box now sorts entries by continuing care date, not alphabetically.

•	 If you selected an appointment in the Appointment Book, clicked Find New Appointment Time on 
the Options menu, closed the Find New Appointment Time dialog box, changed the appointment 
length, and then re-opened the Find New Appointment Time dialog box, the appointment length 
would not update. This has been fixed.

•	 When moving an appointment in the Appointment Book, if the message “Provider is already 
scheduled...” appeared and you tried to open the patient information for that patient, a message 
would appear on multiple Dentrix computers indicating that a patient file was open at another 
workstation. This has been fixed. Closing the Appointment Book while the Continuing Care List 
loaded caused an error and locked the system. This has been fixed. Changing the operatory, time, 
or date of an appointment on the Pinboard did not change the operatory, time, or date in the 
Appointment Book schedule. This has been fixed.

•	 “Ghost” appointments have been eliminated.

•	 When trying to create a patient alert, the user received an error message stating that the current 
patient’s information was no longer valid and may have been edited at another workstation. This has 
been fixed. The Patient Visit Form did not print if the user selected All Patients and Today for a date 
range. This has been fixed. The Last Changed date was not updating. This has been fixed.

•	 The lab case icon (blue L with white background) did not change when the lab case was received and 
the Appointment Book view was refreshed. This has been fixed.

•	 Attaching procedures to appointments with Continuing Care attached doubled the length of the 
appointments. This has been fixed.

•	 When you used the Appointment Book’s Week View, the Hover window did not display all the 
information that it should have. For example, the Work Phone, Mobile Phone, Primary Insurance 
information, Account Balance, and Appt Note did not appear. This has been fixed and the 
information now appears in the Hover window.
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•	 When you refreshed the Appointment Book with an appointment on the Pinboard, Dentrix sent the 
appointment to the Unscheduled List. This has been fixed. 

•	 Moving an appointment from the Unscheduled List to the Pinboard and then attempting to move the 
appointment from the Pinboard to the Appointment Book where the Unscheduled List dialog box 
appeared caused an error. This has been fixed. 

•	 Attaching a treatment procedure to a patient in the Appointment Book and then deleting it caused 
the production amount displayed in the Appointment Book to be incorrect. This has been fixed. 

•	 On the Appt menu of Appointment Book’s Unscheduled List, the Purge Appts option has been 
spelled out to be consistent with other options on the menu. 

•	 If an appointment in the Appointment Book specified non-default fees, and you selected the Always 
Calculate option in the Practice Appointment Setup dialog box, after setting an appointment 
complete, the appointment fees displayed in the appointment block reverted to the default fees. This 
has been fixed. 

•	 When you set a multiple-procedure appointment complete and then scheduled a new recall 
appointment when prompted, the default time assigned to the new appointment was incorrect. 
Dentrix used the old appointment time (based on all the attached procedures for the old 
appointment) instead of calculating a new time (based on the procedures of the recall appointment). 
This has been fixed. 

•	 When you moved an appointment from the Pinboard or Appointment List to the Appointment 
Book, the appointment length would be wrong if the default interval was set to a value other than 10 
minutes. This has been fixed. 

•	 The Select Initial Reasons dialog box in the Appointment Book required scrolling in order to see all 
the available options. This dialog box has been redesigned so scrolling is no longer necessary. 

•	 The scheduled production amounts for an appointment in the Appointment Book did not update if 
you changed attached treatment plan amounts. This has been fixed. 

•	 When you archived patients, Dentrix deleted their completed appointments from the Appointment 
Book. This has been fixed. 

Collections Manager
•	 If you displayed all collection results in the Collections Manager and then switched to a filtered 

view (one that excluded some payment agreements or future due payment plans, for example), the 
Collections Manager would display incorrect information for certain patients. For example, it would 
display information for a patient in the previous list as the information associated with the patient in 
the new filtered list. This has been fixed. The Collections Manager did not display the correct name 
list. This has been fixed.

Document Center
•	 Keyboard shortcuts were added to the Document Center’s Acquire menu.

•	 Received an error message when trying to print a rich text format (RTF) document. This has been 
fixed.

•	 When exporting images from the Document Center, if you specified a different file type than the 
current file type, the Document Center would save the file using the specified file extension but 
would not convert the file to the new format specified. This has been fixed.

•	 Could not preview images if they had different regional settings when they were imported. This has 
been fixed.

•	 The Document Center could import, export, and email HTML and XML files, but these file types could 
not be previewed or printed. This has been fixed.

•	 If more than 40 items are present in the Unfiled Documents list when the Document Center is closed, 
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a message now appears and gives you the option of opening the Unfiled Documents list. Problems 
that prevented you from printing documents from the Document Center tree to the Document 
Center printer driver have been fixed.

•	 Printing labels to the Document Center Printer using the 5160 mailing labels option would send 33 
labels instead of 30. This has been fixed.

•	 Using the Combine option to merge two or more documents in Unfiled Documents caused the 
second document to display a gear until it was manually refreshed. This has been fixed.

•	 Pasting text from Microsoft Word into the Document Center and then printing would cause an error 
message to appear. This has been fixed.

•	 When attempting to export a document from the Document Center and replace an existing file with 
the same name, the Document Center would not replace the file. This has been fixed.

•	 If you set the Document Center Statement Count to a value that was less than the number of the 
actual number of billing statements being printed to the Document Center, some statements did not 
appear correctly. This has been fixed.

•	 Signing a document in the Document Center and then clicking Refresh would cause the Export 
button to become disabled. This has been fixed.

•	 After setting the file attributes of a file in the Document Center to “Read-Only” or “Hidden,” the 
Document Center would no longer import PDF files. This has been fixed. The medical claim form now 
includes the medical procedures and medical fee schedule, rather than the dental procedures and 
dental fee schedule.

•	 A number of scanners set up to use WIA or TWAIN did not function properly. This has been fixed with 
the auto-acquire feature. Using this feature, you can have a scanner save supported file types (.jpg, 
.pdf, .bmp, .png, .doc, .xls, and so on) to a folder you specify.

•	 The Send Document(s) and Export Document(s) options in the File menu are not available when an 
image is attached to a claim. This has been fixed.

•	 Text files attached to claims incorrectly produced the “Attachment file . . . not found!” error message. 
This has been fixed.

•	 The Document Center printer was not properly registered during installation. This has been fixed.

•	 Received the error message “Error creating attachment” trying to acquire a PDF file automatically. 
This has been fixed.

•	 When you viewed any OLE document type in the Document Center, the viewer wrote the file to the 
TEMP folder, but in some cases would not remove the file after viewing or closing the Document 
Center. This has been fixed, and the file is now removed from the TEMP folder after viewing. 

•	 The right-click shortcut menu in the Notes text box (with options for Cut, Copy, Paste, and so forth) 
that was available in earlier versions of Dentrix was not available in the G4 version. This shortcut 
menu has been added back to the Notes field. The Type field for claim attachments in the Document 
Center now defaults to Supporting Info as it did in Dentrix G2 and prior versions. 

•	 When using the Logitech QuickCam Chat camera on a Windows 7 computer to capture an image 
using the “Quick Scan” button, Dentrix displayed the message, “Error to set capability value.” This 
has been fixed, and the error no longer appears. 

•	 You could customize the Unfiled Documents toolbar in the Document Center, but Dentrix did not 
save the toolbar changes after closing the Document Center. This has been fixed. 

•	 When you attached a patient to a document in the Document Center, if you attached more than 
one patient in the Modify Document Attachments dialog box, an unhandled exception error could 
appear and cause the Document Center to close. This has been fixed. 

•	 After you modified a document in the Document Center that was attached to more than one patient, 
if you selected another document, you were not prompted to save the changes you made to the 
original document. This has been fixed. 

•	 If a document in the Document Center contained slashes (“/” or “\”) in the document description, 
such as a date (05/12/2012), you could not export the document. The Send Document(s) button and 
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Send Document(s) on the File menu would not respond when clicked. This has been fixed. 

•	 When you acquired new images in the Document Center, the Modify Document Attachments dialog 
box opened behind the Document Information window. This has been fixed, and the dialog box now 
opens in the foreground as it should. 

•	 When you attempted to capture and import an image with a webcam using the OEM dialog box, 
after the Document Information dialog box fields were filled out and submitted, the Quick Scan 
dialog box did not close, and Dentrix appeared to not complete the import. The Document Center 
could only be closed through the Windows Task Manager. This has been fixed. 

•	 You can use a multi-function printer, such as the Dell 2335dn laser printer, to print reports. You can 
also scan multiple documents and color images to the Document Center.

Family File
•	 In the Family File’s Continuing Care module, setting the filter to display “All” showed all patients in 

the database, not just those in the currently selected family. This has been fixed, and the Continuing 
Care module now shows only patients in the current family. 

•	 When deleting a patient, the Family File now checks to see if the patient record includes any signed 
documents, clinical notes, questionnaires, or Document Center Files and asks if you want to continue 
if any of these are found.

•	 When selecting a Carrier under Select Primary Dental Insurance Plan in the Family File, if two plans 
had the same name, the first one listed would be highlighted by default (even if it wasn’t the one 
assigned to the patient). If you clicked the double-arrows next to Carrier and then clicked OK or 
pressed Enter, Dentrix would change the patient’s insurance to the default plan that was highlighted.
This has been fixed. The Select Payor ID dialog box loaded slowly. This has been fixed.

•	 When using the New Patient Appointment method to add a new patient, if you then added a family 
member with a Non-patient status to the family, Family File would record the additional family 
member as a family referral. Family File no longer records it as a referral.

•	 You can add more than 18 patients to a family when you archive some of the patients in the family. 
This has been fixed.

•	 The error message, “Cannot open patient file” would appear when closing Family File if the Dentrix 
Help window was open. This has been fixed.

•	 If a long e-mail address (longer than 40 characters) is entered for a patient, the More Information 
dialog box now includes ellipses points (...) to represent the part of the e-mail address that is too long 
to appear in the field.

•	 When using the Advanced Search tab in the Select Patient dialog box, you can now open the patient 
records for archived patients.

•	 If Continuing Care was attached to an appointment in the Appointment Book, when you viewed the 
More Information dialog box in the Family File for that patient, the Provider field under Continuing 
Care would be blank. This has been fixed.

•	 If the Practice Resource Setup dialog box was open on any Dentrix computer when you tried to 
change patient information in the Family File, you would see a message stating that a resource file 
was open. (This scenario could also cause other error messages to appear.) If you cancelled the 
message, Dentrix would save your patient information changes anyway. The lock was unnecessary 
and the messages no longer appear in this scenario.

•	 Archived patients were listed in (and could be selected from) the Previously Selected Patient list, but 
their patient information could not be opened for editing. This has been fixed, and archived patients 
are no longer listed in the Previously Selected Patient list.

•	 When printing a Referral Label from the Referral box in the Family File, no space was added between 
the doctor’s middle initial and last name. This has been fixed.

•	 Could not simultaneously edit the same Continuing Care Type on different workstations for different 
patients. This has been fixed.
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•	 Could not update the coverage table when adding payment table entries. This has been fixed.

•	 Patient Medical Alerts are now listed alphabetically in the Family File. The Do Not Bill to Insurance 
option in the Ledger was selected when the patient’s appointment was set complete even though 
that option was cleared in the Family File if the patient’s insurance was not the same as the 
guarantor’s. This has been fixed.

Installation
•	 When you installed a Dentrix software update on some computers, the Smart Update Installer 

displayed an error message stating that it “encountered a problem and needs to close.” This has 
been fixed. 

•	 When you installed or upgraded Dentrix on a computer with an Adobe Flash player version higher 
than 9.0, the following error message appeared: “Error 1904. Module failed to register. HRESULT 
-214722043.  Contact your support personnel.” This has been fixed. With the Dentrix G6 installation, if 
the appropriate Adobe Flash player is already installed, it will not re-install the Flash player or display 
an error message. 

Ledger
•	 Procedures were posted in reverse order. This has been fixed.

•	 Insurance claim adjustments were posted to the wrong patient account. This has been fixed.

•	 When the amount of a payment exceeded the current aging amount, the aging amount under 
MTDCur in Receivables Analysis could add up to more than 100%. This has been fixed.

•	 Procedures selected as Do Not Bill to Insurance appeared as an outstanding balance to insurance. 
Expected amount from insurance showed correctly as $0.00. This has been fixed.

•	 You could change which patient to apply a payment to even though a procedure had been moved to 
history. This has been fixed.

•	 If a Future Due Payment Plan was set up, charges were posted at month end even though a payment 
wasn’t due that month. This has been fixed.

•	 The Audit Trail Report included an audit record for a split payment even if the payment was not split. 
This has been fixed.

•	 When printing the Payment Agreement Coupon Books and the Payment books for the future due 
payment plans, Dentrix would truncate the name of the office after several letters. This has been 
fixed.

•	 When typing notes after double-clicking a procedure in the Ledger, if no claim was attached, you 
could press Enter to move to a new line. However, if there was a claim attached, pressing Enter would 
close the View Procedure Attached to an Insurance Claim dialog box but save what was typed. Now, 
pressing Enter always moves to a new line in the notes without closing the dialog box if it is open.

•	 If you began the process of posting an insurance payment in the Ledger, but then opened a different 
patient in the Ledger before clicking OK/Post to complete the process, when you subsequently 
posted the payment for the first patient, it would not post to the correct patient. This has been fixed.

•	 Posting an additional payment to a claim already in history using the same cheque number would put 
the new payment into history also and combine it with the previous payment. Now, a new payment is 
added to the Ledger.

•	 In the Billing/Payment Agreement Information dialog box, the Balance for PA amount would be 
different depending on whether the payment agreement was created in the Ledger or the Family File. 
If the Ledger was used, the Balance for PA amount would display the Family Portion of Balance. If 
the Family File was used, the Balance for PA amount would display the Family Balance. The field now 
displays the Family Portion of Balance regardless of where the payment agreement was created.

•	 Posting a multi-code for the same patient on two different Dentrix computers at about the same time 
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would cause the message “A necessary file is in use” to appear for a couple of minutes. This has 
been fixed.

•	 The Do Not Bill to Dental Insurance option in the Procedure Code Editor dialog box is now reset if 
the posted code is changed.

•	 If you deleted a claim and then used a different computer to modify a note on a procedure attached 
to the deleted claim, the Ledger would display the error message, “An Insurance Claim That Was 
Previously Created For This Procedure Cannot Be Found.” When this happened, the database would 
need to be repaired. This has been fixed.

•	 When posting an insurance payment, if the Patient Information dialog box from the Family File 
was open for the patient, Dentrix would display a message saying that the patient file was open at 
another workstation. After clicking Cancel, this message would re-appear three more times, followed 
by a message saying that the patient information was no longer valid. The Ledger would then clear 
the selected patient information while leaving the claim open, post the insurance adjustment but not 
the payment, and leave the claim set to Sent. This has been fixed; the error messages and file locks 
work properly and only when needed.

•	 When posting an insurance payment, if the Patient Information dialog box from the Family File 
was open for a subscriber, Dentrix would display a message saying that the patient file was open at 
another workstation. After clicking Cancel, Dentrix would display messages saying it could not read 
the patient file. This has been fixed; the error messages and file locks work properly and only when 
needed.

•	 When attaching images to a claim using Dexis Integrator, if you double-clicked on the image button 
instead of single-clicking, the Ledger would stop responding. This has been fixed.

•	 If the path to the Dentrix program files was C:\Program Files\Dentrix and a file with the name 
“program” existed in the root of the C: drive, the Month End Wizard would not launch. This has been 
fixed.

•	 If a patient had primary and secondary insurance with a primary insurance claim in the Ledger, if 
secondary insurance was cleared from the Family File, there was no way to update the primary 
insurance claim to reflect this change. This has been fixed.

•	 Orphaned claim estimates were incorrect. This has been fixed.

•	 When you print a Walkout Statement and select the Print the Doctor Recommendation option, all 
supported versions of Word are now able to launch and print the document.

•	 When printing a Walkout Statement with a Recommendation Document, Microsoft Word now closes 
after it has finished printing.

•	 The Split Claims dialog box displayed amounts incorrectly. This has been fixed.

•	 Under certain conditions, procedures that involved multiple surface entries were not being posted 
correctly in the Ledger. This has been fixed. If you printed a Walkout Statement with 21 to 24 
procedures in the Ledger with the Family Walkout and Print Doctor Recommendations options 
selected, an additional blank walkout statement printed with the text Procedure Recommendations 
printed over the text Statement of Services Rendered. This has been fixed.

•	 If you print a claim with a postdated procedure for a tooth with surfaces and a current date procedure 
with no surfaces, the surfaces print for both procedures. This has been fixed.

•	 The secondary insurance override was blank when the user clicked the All (with running balance) 
option in the View menu. This has been fixed.

•	 Clicking the Fast Checkout button in the toolbar opened the wrong dialog box. This has been fixed.

•	 Totals were incorrect when split payments were posted. This has been fixed.

•	 Splitting payments caused an error message to appear. This has been fixed.

•	 Splitting payments by family members showed only part of the payment. This has been fixed.

•	 Dentrix previously let you delete a patient even if the patient had a pending payment adjustment 
or other transaction posted to the Ledger. This left unresolved transactions in the database and 
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calculation issues for Dentrix. This has been fixed, and Dentrix now displays a message stating that 
you cannot delete the patient because the patient has unresolved transactions.  

•	 When you selected the Auto-Receive Secondary Claim if No Pending Ins Estimate option in the 
Ledger and then posted a partial payment and write-off equal to the full amount of the claim, the 
Ledger did not auto-receive the secondary claim as it should. This has been fixed. 

•	 A certain sequence of procedure posts followed by certain changes to those posts in the Ledger 
could result in a “positive payment” in the Ledger. This should not be allowed; all payments in the 
Ledger should post as negative values. This has been fixed, and “positive payments” in the Ledger 
are no longer possible. 

•	 The error message, “A Dentrix module is still active. Close all Dentrix modules except Ledger before 
performing this function” appeared when you ran Month End Update after posting a payment to a 
claim. This has been fixed. 

•	 Once you moved an adjustment attached to a claim to history, you could no longer access it to view 
its note. This has been changed, and you can now open the Enter Adjustment dialog box to view the 
note; however, all options are disabled to prevent changes. 

•	 The tab order in the Ledger’s Single Billing Statement dialog box has been changed. 

•	 When you posted a payment or adjustment in the Ledger’s Enter Adjustment dialog box, Dentrix 
allowed you to delete the patient name in the Patient field (using the Delete key, Backspace key, 
or Delete option on the shortcut menu). This produced several undesirable results: the payment or 
adjustment only appeared in the Ledger if you viewed All with Running Balance; the balance was 
correct in the Ledger but the payment or adjustment would not appear on the Day Sheet, creating 
totals issues for the customer; other reports were also affected. This has been fixed, and you can no 
longer delete the patient name in the Patient field. 

•	 When you posted a procedure to a range of permanent teeth in the Ledger, Dentrix let you use a 
hyphen to separate the range. However, if you tried to use a hyphen to separate a range of primary 
teeth, the Ledger displayed an “Invalid range” error. This has been fixed. 

Office Journal
•	 If passwords are enabled and the Office Journal is opened, the logged in user is not automatically 

selected. This has been fixed.

•	 If you deleted a billing statement from the Office Journal and recreated it, Office Journal would not 
refresh to show the new billing statement. This has been fixed.

•	 If you added an Office Journal note with the same Date, Time, and Type as another Office Journal 
note, the message “Error adding record to Journal table: 2” would appear. This message no longer 
appears.

•	 Printing Office Journal entries for a provider would, under some circumstances, cause the report to 
print with the wrong provider’s name at the top. This has been fixed.

•	 A broken appointment in the Office Journal now includes the appointment reasons as part of the 
description.

•	 Opening the Office Journal from the Family File after adding a specific note in the Billing/Payment 
Agreement Information dialog box would cause Dentrix to display a “Runtime Error!” This has been 
fixed.

•	 An Office Journal entry appeared for patients who were referred to the doctor rather than for the 
patient who made the referral. This has been fixed.

•	 Patient alerts triggered by Add to Office Journal are now displayed when an Office Journal entry 
is added using the Add Journal Entry button in the More Information dialog box. Received error 
message “Unspecified error” when viewing billing statement entries. This has been fixed.
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Office Manager
•	 Could not set a procedure’s time unit to 0 in the Procedure Code Editor dialog box. This has been 

fixed.

•	 Patients with credit balances were excluded from the Referred By Doctor/Other Report. This has been 
fixed.

•	 If a patient had two Continuing Care appointments, the letter merge function incorrectly pulled the 
earliest dated appointment for the postcard reminder.

•	 Selecting a Continuing Care Type with no description in the Patient Report View dialog box and then 
merging a letter caused all patients with a Continuing Care Type to appear on the View List. This has 
been fixed.

•	 If you performed a letter merge and a patient had an unscheduled and a scheduled appointment in 
the selected date range, the patient was excluded from the search. This has been fixed.

•	 Letter Merge and Quick Letters now support long filenames to integrate better with files created in 
Microsoft Word. Fields where these filenames appear have also been extended.

•	 In the Office Manager’s File menu, the Clear (Deselect All) and Refresh options did the same thing. 
The Clear (Deselect All) option was removed, and the Refresh option was renamed to Refresh/Clear.

•	 When merging letters in the Office Manager, the position of some fields in the Patient Report View 
dialog box have changed, making it easier to specify the names of the merge files.

•	 In the Office Manager, the Letters menu name was changed to Letters & Custom Lists. The name of 
the dialog box that opens was also changed.

•	 Running a letter merge for a range of insurance carriers with the same name shows all patients for 
all plans instead of only showing the patients on the plans within the specified range. This has been 
fixed.

•	 Setting the “Existing Patients with NO appointments in date range” and the “Without Attached 
Appointment” options and then performing a letter merge causes the “No records that match your 
query were found” error message to appear. This has been fixed.

•	 The Office Manager’s Label Printer settings were not being saved after you closed the Office 
Manager. This has been fixed.

•	 In the Patient Summary Report, the number/count that was reported for Age 65 and Over and for 
Age 12 and Under was not correct for the month of February. This has been fixed.

•	 The Office Manager would stop responding if you tried to add more than 97 providers at one time 
(one after another, without closing the Office Manager). This has been fixed.

•	 In the Office Manager’s Preferences dialog box, if any of the forms on the Statement Forms tab was 
not selected, the Month End Wizard would not show all available options. This has been fixed.

•	 In the Dental Insurance Plan Information dialog box, the Change Plan for All and Add As A New 
Plan options did not appear after you edited the Employer field. This has been fixed.

•	 In the Office Manager, if you defined a fee schedule name that was seven characters long and then 
edited the fee for a procedure from the Procedure Code Setup dialog box, fees under $10 would not 
be displayed. This has been fixed.

•	 If you tried to add more than 250 staff members, Dentrix displayed an error message but did 
not explain the limitation. Now Dentrix displays a message letting you know that additional staff 
members can’t be added.

•	 Appointment Type definitions can now be deleted in the Office Manager.

•	 Adding a student status to medical insurance before the patient’s insurance information was added 
would cause a “Cannot write” error message to appear. This has been fixed—the error message no 
longer appears.

•	 Importing a custom-created fee schedule that had only two columns could cause an “Unhandled 
exception” error message. This has been fixed.
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•	 In the Fee Schedule Setup dialog box, if you selected a fee schedule and pressed Delete, the fee 
schedule would immediately be removed from the list without warning. This has been changed—the 
Delete key no longer does anything in this dialog box.

•	 If you marked a procedure as “Invalidated,” using the Office Manager’s Batch Insurance Claims tool 
would still create a claim for the procedure. This has been fixed.

•	 In the Print Preview dialog box, clicking Default Page Size now displays the document using the 
default page size (when the dialog box was opened) rather than using a smaller page size.

•	 Inactivating a staff member attached to an appointment with a status definition that is blank would 
cause an “Application Error” message to appear. This has been fixed.

•	 When performing a letter merge, clearing certain options would automatically clear other options. 
Now, letter merge options are only cleared or selected when you click them individually with the 
mouse.

•	 When merging letters, if the Insert Multiple Referrals in Single Letter option was selected in the 
Select Referred By Range dialog box in the Patient Report View, Dentrix would display a “Header 
Record Delimiter” error followed by multiple “Invalid Merge Field” error messages. This has been 
fixed.

•	 When using the merge field «PP_Payment_Date», the merge would pull the First Pay Date instead of 
the actual Future Due Payment Due Date. This has been fixed.

•	 The letter merge does not include all of the appointments for patients having multiple appointments 
on the same day. This has been fixed. When a new patient is created and does not yet have a Last 
Visit Date because no work has been completed, letter merge data files would report the Last Visit 
Date the same as the First Visit Date. Dentrix now leaves the Last Visit Date blank in this situation.

•	 Selecting the Referred To letter merge filter would clear the Pri Dental Ins filter option. This has been 
fixed.

•	 Opening the Referred By dialog box during a letter merge would clear the letter merge 
Appointment filter. This has been fixed.

•	 When specifying a data range in a letter merge or query, if the beginning field for the range was left 
blank, the query results could be inconsistent and incorrect. This has been fixed.

•	 All letter templates have been updated to improve the writing.

•	 When using letter merge, sometimes one patient’s Due Date would also be used with the next 
patient if that patient had a blank Due Date field. This has been fixed.

•	 When using letter merge to create a “Prospective Patients” letter, if you selected the Prospective 
patients with appointment in date range option in the Appointments filter in the Patient Report 
View dialog box, no practice data was in the merged letter. The practice data is now included.

•	 Defining 20 Continuing Care types in Dentrix and selecting the ALL check box for Continuing Care 
types when doing a letter merge would cause the resulting merge data to contain incorrect results 
and cause other problems. This has been fixed.

•	 Using Quick Letters to print a letter would cause any documents that were open in Word to close 
without warning. This has been fixed. Totals for end balances and total receivables in the Practice 
Analysis Report did not match. This has been fixed.

•	 Copying procedure notes to clinical notes added two blank lines between multiple procedure notes. 
This has been fixed.

•	 The Treatment Planner icon was enabled, even though a patient was not selected in the List Manager. 
This has been fixed.

•	 When you previewed some reports in Dentrix Print Preview, the report background occasionally 
disappeared until you used the zoom feature to zoom in on the report. This has been fixed.

•	 When you selected Compare to Fee Schedule in the Day Sheet dialog box and printed a Day Sheet, 
the tooth ranges printed as random symbols. This has been fixed.
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•	 When you deleted a medical alert in the Office Manager and selected a replacement alert, the 
replacement alert was not assigned to patients that had the old alert assigned to them. Instead, a 
blank medical alert appeared. This has been fixed.

•	 In the Practice Passwords Setup dialog box, four password rights were renamed “Generate Aging/
Patient Balance Reports,” “Generate Appointment Book Views,” “Generate Practice Analysis 
Reports,” and “Generate Referral Slip or Recap.”

•	 Entering a very long description for a dental diagnostic code in the Office Manager caused the code 
to display the wrong information, and the code could not be edited. This has been fixed.

•	 When running the Inactive Patient List, if you selected either With Last Visit Before <today’s date> 
or With No Continuing Care and Not Future Appointments, the report did not include the correct 
patients. This has been fixed.

•	 An archived patient could appear on the Referred By Doctor/Other Report. This has been changed, 
and archived patients no longer appear on this report.

•	 Two items in the Office Manager’s Dentrix Print dialog box (Properties and All Pages) used the letter 
“P” as the shortcut key. This has been fixed; All Pages now uses the letter “E” as the shortcut key.

Patient Chart
•	 The “Image, Open” password security right was not linked to the toolbar buttons on the Image Panel 

toolbar. From the Patient Chart, you could click Image > Switch To > Digital X-Ray and would see the 
message, “The current user does not have rights,” but if you clicked the Digital X-Ray button in the  
Image Panel toolbar, you were granted access. Now both ways of accessing Digital X-Ray respond to 
the security right consistently.

•	 If you created a custom procedure code and included a space at the end of the name, the Patient 
Chart would always post the custom code. This has been fixed.

•	 The Patient Chart label did not display properly when a middle initial was missing from a patient’s 
name. This has been fixed.

•	 If you set the Progress Notes panel in the Patient Chart to display expanded notes and then changed 
to any other chart view or layout, the expanded notes would return to the default notes view. This has 
been fixed.

•	 Closing the Patient Chart’s Chart Notations while the Lasso tool was still busy caused an “Unhandled 
exception” message to appear. This has been fixed.

•	 After a claim was created, the provider could be changed. This has been fixed.

•	 Retainer crowns for different quadrants were painted inconsistently in the Patient Chart. The upper 
left and lower right quadrants painted without connection paint between certain teeth; the upper 
right and lower left quadrants painted with connection paint between some teeth. These are now 
painted consistently in all quadrants.

•	 The Patient Chart was loading slowly. This has been fixed.

•	 If an office upgrades to .NET 4.5.1 and uses Dexis 9/10 and Integrator 3.0, the Patient Chart freezes. 
This has been fixed.

•	 Viewing the Patient Chart using the View by Progress Notes View after invalidating a posted 
procedure would cause the invalidated procedure to continue displaying. This has been fixed.

•	 A partial denture would appear painted inconsistently in the Patient Chart using certain tooth ranges. 
This has been fixed.

•	 After a treatment plan containing an extraction is complete, the Patient Chart now displays the 
extraction correctly by no longer displaying the extracted tooth in the chart.

•	 After changing the Patient Chart’s display setup theme three times, it would revert back to the default 
theme. This has been fixed.

•	 When customizing the Patient Chart toolbar (and some other toolbars), if you renamed the Toolbar 
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in the Rearrange Commands dialog box, the toolbar changes were not saved after closing and 
reopening the Patient Chart. This has been fixed.

•	 Editing a procedure button image multiple times could cause the file where the image is stored to 
increase dramatically in size and become corrupt, causing the software to run more slowly. This has 
been fixed.

•	 When you set the Patient Chart to View Progress Notes By Date and specify a date range for From 
and To, the software now remembers the date range the next time you select this option.

•	 Clinical note categories did not sort correctly when there were more than 24 categories. This has 
been fixed.

•	 Clinical note templates that included more than 240 items or more than 1,565 characters in a 
Response Type would display a message saying the computer was out of memory. This has been 
fixed.

•	 If a clinical note had more than 53 lines, it would print a blank first page before (and sometimes after) 
the clinical note. This has been fixed.

•	 Patient Chart allowed you to post an update to a completed clinical note that was locked and 
entered into history through backdating. This has been changed so that clinical notes which were 
manually moved into history by backdating are locked from editing.

•	 When editing a procedure that uses a tooth range, if you specified only one tooth for the tooth 
range, the tooth number did not appear in the Tooth Range field. This has been fixed.

•	 If a procedure had the treatment area set to Tooth and the paint type set to Surface Restoration, 
posting the code would cause an “Unhandled exception” error message. This has been fixed.

•	 The position of a chart notation in the Patient Chart shifted when you switched from Work Chart View 
to Full Screen View. This has been fixed.

•	 A date and signatory name were not being added to clinical notes after they had been signed. This 
has been fixed.

•	 Clicking Copy All only copied one clinical note. This has been fixed. If you clicked the Refresh button 
in the toolbar after copying a medical alert to a clinical note, the alert would not appear in the clinical 
note unless you closed and then re-opened the Chart. This has been fixed.

•	 Posting treatment planned procedures as complete from the Patient Chart’s Progress Notes caused 
all notations to temporarily disappear. This has been fixed.

•	 When using a Clinical Note Template with prompts for “Tooth Select One” and “Surface Select,” 
selecting “Incisal/Occlusal” for the surface added the surface selection as “O” (occlusal). This has 
been fixed. 

•	 When you selected a billing type in the Patient Chart, updating the Treatment Plan Fees did not 
update the fees. This has been fixed. 

•	 When you created a clinical note in the Patient Chart, clicking Insert Dateline surrounded the dateline  
with quotation marks: “--------------Wed - 28 Mar 2012--------------.” The quotation marks were not 
inserted prior to Dentrix G3. This has been fixed, and the quotes are no longer inserted. 

•	 Changes customizing the Patient Chart toolbar were not saved after clicking View > Chart Layout > 
Save Current Layout. This has been fixed. 

•	 After recording an implant removal in the Patient Chart, the Patient Chart’s Graphic Chart did not 
update the painting for the tooth to reflect that the implant had been removed. This has been fixed. 

•	 An unhandled exception error occurred when the Patient Chart launched. The chart was empty and 
the toolbars and panels did not work. This has been fixed. 

Perio Chart
•	 The Perio script was using a trailing cursor that allowed the selection to move ahead to the next 

tooth while the bleeding selection was still on the last tooth. This made it possible to enter a mobility 
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measurement while the bleeding selection was on the previous tooth but the selection was on the 
next tooth. This would apply the mobility data to two teeth. This has been fixed.

•	 When you charted plaque in the Perio Chart using keyboard shortcuts, the measurements were 
applied to two teeth simultaneously when the script is ready to chart the next tooth. This has been 
fixed.

•	 The Copy to Clipboard option in Perio Exam Info now copies the actual perio exam information 
instead of the defaults for the selected exam template.

•	 If you opened a new perio exam after inactivating a provider, the new perio exam would use the 
inactivated provider. This has been fixed, and the Perio Chart now uses the correct provider.

•	 When patient letters are printed along with a perio exam, Dentrix now adds an entry to the Office 
Journal.

•	 When printing clinical notes from the Perio Chart, the Perio Chart would sometimes display a 
message that it had encountered a problem and needed to close. This has been fixed.

•	 When you print a perio chart, the chart information now prints with the practice address rather than 
the provider address (if they are different).

•	 If you closed Perio after entering a Furcation Grade by clicking the FG button, the Save message box 
would not appear. This has been fixed.

•	 On screen, the CAL measurement would appear in red when a reading exceeded the value you set, 
but when it printed, it only printed in red if it exceeded a value of 7. This has been fixed, and it now 
prints in red when it exceeds the specified value.

•	 The Print Perio Chart Letters or Charts password security option didn’t restrict access properly. This 
has been fixed.

•	 When you right-clicked certain areas of the Perio Chart where no functionality was available, the Perio 
Chart displayed shortcut menus with selectable options. Some options did nothing; others opened 
windows that you could not edit. These shortcut menus have been removed. 

•	 When you double-clicked an existing bleeding or suppuration point in the Data Chart and the Data 
Entry pane of the Perio Chart, the two areas responded differently. The Data Entry pane highlighted 
the selection, but in the Data Chart, the bleeding/suppuration point marking disappeared. Both areas 
of the window now highlight the selection. 

•	 If you made changes to the Exam Information in a Perio Chart exam template and saved the 
template, some changes were not saved with the new template. This has been fixed. 

Questionnaires
•	 Setting an existing questionnaire that contained only PI questions to Respondents: Provider/Staff 

would cause a “System index out of range exceptions” error message to appear. This has been fixed.

•	 Clicking the List All option on and off from the View menu caused responses for patients other than 
the selected patient to appear. This has been fixed.

•	 The preview pane did not refresh when you selected a new questionnaire. This has been fixed.

•	 The right-click shortcut menus that were available in Dentrix G3 were not available in Dentrix G4. 
These shortcut menus have been restored.

•	 If you tried to delete an employer from a questionnaire and then update the patient information, 
an error message would appear. A new Clear Employer option has been added under Employer 
Options that lets you clear the employer information.

•	 Clicking Update Patient Information to attach a new patient questionnaire to a patient record in 
some instances could cause the Questionnaires module to stop responding. This has been fixed.

•	 The Best Time to Call field would sometimes appear in red in the Update Patient dialog box even 
though nothing had changed. This has been fixed.
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•	 When a questionnaire form has patient information fields, the New with Only Patient Info option is 
now always active.

•	 When creating a new patient record in the Family File from a questionnaire form submitted through 
the web, if the year of the appointment date did not match the current system year, the questionnaire 
would go back to the select patient screen. This no longer happens, and the user is allowed to finish 
creating the new patient record.

•	 If a new patient appointment was selected in the Select Patient dialog box when moving 
questionnaire responses, an “Unhandled exception” error message would appear. This no longer 
happens; instead, the message “You must select an existing patient to move responses” appears.

•	 In certain cases, a form marked as Provider/Staff Respondent could still be uploaded to the office 
website. When this happens, responses would download and notify users, but the responses would 
not be visible because they were marked as Provider/Staff Respondent. This has been fixed; Provider/
Staff Respondent forms can no longer be uploaded to the office website.

•	 If you tried to open the Questionnaires module from the Patient Chart when a patient with a long 
name was selected, the Questionnaires module would open without the patient selected. This has 
been fixed.

•	 When using the Select Patient dialog box in the Questionnaires module, if you selected a new 
patient appointment from the Appointments tab, nothing happened. This action now displays the 
message, “A new patient cannot be selected until their information has been updated in the Family 
File.” If you cleared a toolbar from the right-click menu, the toolbar was still selected in the View 
>Toolbars option. This has been fixed.

•	 If you tried to open the Questionnaires module from the Patient Chart when a patient with a long 
name was selected, the Questionnaires module would open without the patient selected. This has 
been fixed.

•	 Dentrix previously allowed you to move a signed questionnaire to the same patient and asked if 
the signature should be removed. When you clicked Yes, Dentrix removed the signature from the 
response. This has been fixed, and you can no longer remove a signature by moving the response to 
the same patient. 

Reports
•	 Printing a Billing Statement from the Print Preview dialog box does not update the Last Statement 

Date field in the Ledger or the Office Journal. This has been fixed.

•	 In the Practice Advisor Report, the case acceptance totals did not include completed treatment-
planned procedures. This has been fixed.

•	 Excluding days with no transactions from the Provider A/R Report caused the beginning balance to 
be incorrect when run according to the procedure date. This has been fixed.

•	 The Deposit Slip showed a single provider for payments split between multiple providers. This has 
been fixed.

•	 Totals in the Practice Treatment Case Report were incorrect. This has been fixed.

•	 The Patient Notes Report was not printing correctly when patients had multiple patient alerts. This 
has been fixed.

•	 When running the Practice Advisor Report, if the fiscal month in Practice Setup had a month of 0 or 
some other invalid value, Dentrix displayed the error message, “Year, Month, And Day Parameters 
Describe An Un-Representable DateTime.” This error message no longer appears.

•	 If you launched Dentrix from the Dentrix Launcher at system startup, running the Daily Huddle Report 
or Practice Advisor Report would cause the error message “Cannot find file specified” to appear. This 
has been fixed.

•	 If a patient had a Future Due Payment Plan and you selected the Payment Plan Notes option when 
you printed or previewed the Patient Notes Report, the report would not generate. This has been 
fixed.
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•	 Patients without insurance would appear on the Daily Huddle Report with the Insurance not Eligible 
box selected. This has been fixed, and this box is no longer selected on the report.

•	 In the Daily Huddle Report, the Prior Day field now reports statistics for the “prior day” that the office 
was opened. Previously, it would report statistics for the prior day even if the office was closed that 
day.

•	 The Appointment Book View Report will not print if the patient’s referral has a combined name length 
of 49 characters. This has been fixed.

•	 If the Appointment Status definition was missing for certain appointments when running the Daily 
Huddle Report, an error message would appear and the report would not be generated. This has 
been fixed; the error message no longer appears and the report will now generate properly.

•	 On the Daily Huddle Report, some patients who were not past due would still appear under Patients 
who have a family Payment Agreement Past Due on the Scheduled Patients List. This has been fixed.

•	 The Day Sheet included inactive providers even when the List Inactive option was cleared. This has 
been fixed.

•	 The Chronological Day Sheet is now sorted chronologically.

•	 The Aging Report did not display the Provider IDs when the sort option By Largest to Smallest 
Balance was selected. This has been fixed.

•	 Generating the Insurance Aging Report for certain groups would produce a report that included 
other groups as well. This has been fixed.

•	 The Insurance Transaction Analysis Report in the Practice Assistant did not include secondary 
insurance information when the Include Secondary Claims option was selected. This has been fixed.

•	 A treatment plan procedure that is attached to a broken appointment now appears on the 
Unscheduled Treatment Plans Report.

•	 The Future Due Payment Plan Report would sometimes include an incorrect number of payments and 
negative payment amounts. These issues have been fixed.

•	 The Walkout Statement and the Attending Doctor’s Statement included the Balance Forward amount 
without a description. This has been fixed, and the Balance Forward amount no longer appears on 
these statements.

•	 If you used the Full - Credit Card Statement form when printing single billing statements, the Credit 
Card information was not included. This has been fixed.

•	 In the Practice Statistics Report, if you added all the percentages from the age statistics, the total 
didn’t always equal 100 percent. This has been fixed.

•	 Selecting the Include patients without production option in the Referred By Patient Report caused 
production to display in the report as 0 when it should be the production value. This has been fixed.

•	 The Analysis Summary Report would sometimes count the Patients Seen line on the report for the 
same patient twice. This has been fixed.

•	 The Batch Insurance Payment Entry dialog box did not fit entirely on screen if your resolution was set 
to 1024x768. This has been fixed.

•	 Clicking Statement Notes in the Guarantor Notes dialog box didn’t do anything if the Verify Billing 
Statements to Send option was selected. It now opens the Insert Custom Billing Statement Notes 
dialog box.

•	 Printing an Unscheduled Treatment Plan Report for an individual patient would also print reports for 
all patients with the same last name. This has been fixed.

•	 If the Daily Summary option on the Analysis Summary Report is not selected, this summary section no 
longer appears on the printed report.

•	 When a patient had multiple appointments scheduled on the same day, the Route Slip/Patient Visit 
Form did not print information for the additional appointments on that day. This has been fixed.

•	 If two adjustment types with the same name were included in the Provider A/R Totals Report, one of 
the adjustment types would be duplicated while the other would be missing. This has been fixed.
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•	 If the Include Daily Summary option was selected when printing the Provider AR Totals Report, 
Dentrix would display a message that the report was “Printing to Document Center,” but the report 
would not finish printing. This has been fixed.

•	 When the Include Check Detail option is selected, the Daily Collections Report now only includes the 
check details in the Check Details part of the report to avoid confusion.

•	 The Referred by Patient Report and Referred to Doctor Report included some names outside of the 
selected range. This has been fixed.

•	 The Patient Visit Form now sorts the operatories correctly.

•	 The Route Slip now sorts all future appointments chronologically.

•	 The Practice Analysis Report when set to Production By Category would show a procedure code as a 
category if there were procedures that met the report criteria in the [NONE] category. This has been 
fixed.

•	 A Dentrix application error appeared when running an Aging Report with a note exceeding 933 
characters and Print to File selected. This has been fixed.

•	 Running the Insurance Carrier List Report with Include Subscribers selected did not list the correct 
number of subscribers. This has been fixed.

•	 When generating an Employer List, the Office Manager would stop responding if the list contained 
more than 20,000 patients attached to employees. This has been fixed. The Practice Advisor Report 
showed all Continuing Care Types on the cover page even if only one was selected. This has been 
fixed.

Time Clock
•	 The Time Clock Report data didn’t perfectly match the History window data (it was off by a decimal) 

due to a rounding inconsistency. This has been fixed.

•	 The Time Clock now updates immediately after deleting a manual Time Punch Entry.

•	 In the Time Clock tool, the following text was added to the bottom-left corner of the dialog box: 
“Click to the right of ‘In’ or ‘Out’ to add or edit a time.”

•	 When entering a note on the Time Clock’s History tab, if you typed a “$,” Dentrix would move the 
“$” symbol to the beginning of the note. This has been fixed.

•	 The text of the warning message that appeared when you inactivated a provider indicating that all 
time clock data for the provider will be removed has been deleted. Time clock data is not removed 
when a provider is inactivated.

•	 When using the Time Clock’s date range calendar on the History tab, after entering a time value, 
if you clicked the < or > buttons to move to the previous or next month, a Save Changes message 
appeared and the calendar kept scrolling indefinitely. This has been fixed.

Treatment Manager
•	 Results were inconsistent depending on the date range set in the Next Appt field in the Treatment 

Manager View dialog box. This has been fixed.

•	 The Next Appointment Reason appeared correctly in the Treatment Manager preview window but 
printed with a “CC” instead of “TP.” This has been fixed.

Treatment Planner
•	 When a treatment plan case that contains a signed consent form is deleted, a warning now appears, 

advising you to print the treatment plan and consent forms to the Document Center.

•	 If a patient did not sign the consent form, when the patient opened the consent form later, the Name 
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field under the signature box would be blank. This has been fixed.

•	 If you created a consent form in the Treatment Planner and cleared the Do Not Include Procedure 
Codes on Consent Form check box, procedures would not appear on the consent form. This has 
been fixed, and the procedures now appear on the consent form.

•	 If you selected Do Not Include Procedure Codes on Consent Form when creating a new consent 
form and then attached the form to a treatment case, the procedure codes still printed and blank 
space was added to the form. This has been fixed.

•	 Once you assigned a default case note template, you could not remove it. This has been fixed.

•	 In the Update Treatment Plan Fees dialog box, the All check box under Billing Type for Patient’s 
Guarantor is now disabled (cannot be changed).

•	 When printing a Treatment Case from the Treatment Planner, if the Signed Consent Forms option 
was selected, the treatment case would print on two pages instead of one. It now prints on a single 
page.

•	 Treatment Plan Cases were deleted even if patients had signed a consent form. This has been fixed.

•	 When you print a Treatment Case, the Compared Fee Schedule header text is different from all the 
other text on the report. This has been fixed.

•	 Updating the procedure fees of treatment cases using the Treatment Plan Fees utility changed 
treatment plan dates to the current date regardless of the status of the treatment case. This has been 
fixed.

•	 The Treatment Planner did not automatically refresh after making changes to a consent form. This has 
been fixed.

•	 Under certain conditions, printing a Treatment Plan Case included procedures that were never 
treatment planned. This has been fixed.

•	 Printing a Patient Treatment Case Report no longer cuts off individual procedure values that are 
greater than six digits.

•	 Document formatting in Word was not preserved after using Paste to copy the document into the 
Treatment Planner Consent Forms. The formatting from Word is now preserved.

•	 Under certain situations, completed treatment plans could appear on a treatment plan consent form 
for a new treatment plan. This has been fixed.

•	 The Unscheduled Treatment Plan Report had an option to choose patients by status, but the Practice 
Treatment Case Report did not. This option was added to the Practice Treatment Case Report.

•	 Running a Patient Treatment Case Report and excluding certain columns caused subtotals to display 
over other information. This has been fixed.

•	 When printing a Treatment Case, if you selected the Exclude Completed Procedures option, all 
completed procedures were excluded instead of just those in the case. This has been fixed.

•	 The Treatment Planner now allows you to save a treatment case with a note that is longer than 76 
characters.

•	 When printing a treatment plan, if the Print Secondary Insurance option is selected but the patient 
has no secondary insurance, that column will not print.

•	 Several display issues that could be observed when previewing a treatment case have been fixed.

•	 Adding Default Consent Forms to a treatment case would cause an “Unhandled exception” error. 
This has been fixed.

•	 The Exclude Completed Procedures option in the Practice Treatment Case Report dialog box did 
not always exclude completed procedures from the report. This has been fixed.

•	 In the Case Detail panel, the Other Fee field showed 0.00 instead of the correct fee for an unnamed 
fee schedule. This has been fixed.

•	 The Treatment Plan Case Report was not taking Special Adjustments into consideration in the Patient 
Balance. This has been fixed.
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•	 If you accepted a non-recommended case and rejected the other, any new treatment planned items 
would automatically be assigned to the rejected case. This has been fixed.

•	 When signing a consent form in the treatment planner, providers were listed in the Select Provider/ 
Staff dialog box, but staff members were not. Staff members are now listed.

•	 In the Treatment Case Report, the deductible to be applied was adding the deductible from all 
patients in family, not just the one patient. It now shows the deductible for just the one patient.

•	 Using the Edit or Delete dialog box to enter an insurance override would not automatically refresh 
the Insurance Coverage amounts displayed in the Treatment Planner. These amounts now refresh 
automatically when a procedure or amount is edited. Print jobs in the Treatment Planner defaulted to 
the Windows printer instead of the Patient Chart printer. This has been fixed.

•	 The text of a double-digit tooth number overlapped the Description text box when a treatment case 
was printed. This has been fixed.

•	 When you printed a treatment case in the Treatment Planner, an “Alternate Case” footer printed 
on every case, even if no alternate case was defined. This has been fixed, and the “Alternate Case” 
footer no longer prints unless there is an alternate case defined.

•	 The Treatment Case Report (which you access in the Treatment Planner from the File menu by 
pointing to Print, and then clicking Print Treatment Case) previously allowed you to print up to 114 
procedures in the report.  This number has been increased so you can now print up to 200 procedures 
in the report. 

•	 When you printed a treatment case from the Treatment Planner, apostrophes printed as “&apos;”. If 
the insurance name contained an ampersand (&), the ampersand printed as “&amp;”. These issues 
have been fixed. 

•	 If you printed a treatment case in the Treatment Planner without selecting the Sec Ins Portion option 
in the Select Columns dialog box, the Compare To fee in the Totals box did not appear. And, if the 
patient had only primary insurance but not secondary insurance, the Compare To fee in the Totals box 
also did not appear. These issues have been fixed. 

•	 When printing a treatment case from the Treatment Planner, if you set the Number of copies to a 
number other than one in the Print dialog box, the specified number of copies would not print. Only 
one copy would print. This has been fixed. 

•	 When you printed a treatment case from the Treatment Planner, if the tooth number had two digits, 
the tooth number overlapped the description. This has been fixed. 

•	 Using a custom procedure range when updating treatment plan fees for all patients would not 
update the fees. This has been fixed. 

•	 If you saved a fee schedule with no name in the Office Manager’s Procedure Code Editor dialog 
box and then applied that unnamed fee schedule (by selecting its number) in the Treatment Planner, 
the custom value specified in the fee schedule was ignored, and the default fee appeared in the 
Treatment Planner’s Fee column when you previewed or printed the treatment plan. This has been 
fixed. 

•	 If you printed a treatment case from the Treatment Planner panel and then exited the Patient Chart 
before the print job finished, the following error message appeared: “Object reference not set to an 
instance of an object.” This has been fixed. 

•	 If you printed a treatment case with a long patient education note, instead of continuing the note on 
a second page, the Treatment Planner would truncate the note. This has been fixed. 

Miscellaneous
•	 The Net ID has been replaced by the computer name to address Appointment Book refresh issues.

•	 Dentrix will automatically attempt to restart Dentrix services before sending an “Unable to connect” 
message.
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•	 The first Dentrix module that you launch on each workstation resolves the server name to an IP 
address and temporarily stores it for all other modules until they are all closed.

•	 Dentrix Connection Status shows which Dentrix modules are open on which computers.

•	 The text of several error messages was clarified and corrected to make them more helpful.

•	 The Continuing Care module listed patients who did not fit the specified search criteria. This has 
been fixed.

•	 If a patient has more than one appointment and different providers perform the procedures, the 
Clinical Notes post to the same provider if more than one appointment is set complete for the 
patient. This has been fixed.

•	 Clicking an appointment in the Appointment Book while generating a continuing care list causes the 
error message, “Cannot read patient file” to appear. This has been fixed.

•	 A crash that could occur when installing the Dentrix workstation software has been fixed.

•	 Downloading eligibilities automatically caused eSync to crash in some offices. This has been fixed.

•	 If you attempted to open a Dentrix module too many times before the module had time to open, 
Dentrix would display the message, “Cannot find previous instance.” Dentrix no longer displays this 
message.

•	 Several issues having to do with file locks and error messages when multiple instances of a patient 
record are open for editing simultaneously have been fixed.

•	 Archived patients could be accessed in some modules and certain locations of Dentrix where access 
should not have been available. This has been changed, and archived patients can no longer be 
accessed from these areas of Dentrix.

•	 Duplicate appointments appear in the Appointment List. This has been fixed.

•	 When the total number of surface selections was more than five, procedures did not show the correct 
procedure flags. This has been fixed.

•	 When migrating Dentrix to a new server location, the server path in the registry was not always 
updated. This has been fixed.

•	 A problem that caused the message “Module still active” to appear at times when running the month 
end utilities has been fixed.

•	 When no patient is selected on the Appointments tab in the Select Patient dialog box, if you click 
OK, Dentrix now displays the message, “’No patient is selected!”

•	 You could not print to the Document Center Printer if you were using Windows 8 32-bit. This has 
been fixed.

•	 When you mark a lab case as “received” in the Appointment Book using the Received Case button, 
the “received” status is now updated in the Appointment Book icon, and the received date is now 
posted in the Lab Case Manager.

•	 In the Select Patient dialog box, if you typed a letter and pressed Enter quickly before any search 
results displayed, an “Unhandled exception” error would appear. This has been fixed.

•	 Some patient searches in the Select Patient dialog box would return inaccurate search results—for 
example, if one person’s last name (Johns) was the same as another person’s last name (John) plus 
their first initial (S, for Steven).

•	 A scrolling issue when searching by Home Phone # in the Select Patient dialog box was fixed.

•	 When selecting a patient, if you clicked in a blank area of the dialog box so that no name was 
selected, and then clicked OK, an “Unhandled exception” error appeared. This has been fixed.

•	 The on-screen keyboard (available in several Dentrix modules, such as the Ledger, the Office 
Manager, the Office Journal, and so forth) did not work on 64-bit operating systems. This has been 
fixed.

•	 A workstation that used a mapped drive to access a database on a server would lose its connection to 
the database after a reboot or a re-login or after coming out of sleep mode. This has been fixed.



40	 Dentrix G6 Canada

Dentrix G6 Canada Release Guide

•	 Pressing F1 in most Dentrix modules would open the Dentrix Help. However, in four modules (Lab 
Case Manager, Office Journal, Treatment Manager, and Collection Manager) F1 did not open the 
Help. This has been fixed.

•	 The color of the Patient Alerts button was incorrect did not correspond to the patient’s condition. This 
has been fixed.

•	 The end balance and total receivables do not match in the Practice Analysis window. This has been 
fixed.

•	 The More Information dialog box could be opened by Dentrix users who didn’t have the security 
rights to do so. This has been fixed.

•	 If the patient you created a detailed chart label for didn’t have an employer specified in the Family 
File, an error occurred. This has been fixed.

•	 eDex closed shortly after loading patients. This has been fixed.

•	 The Add Journal Entry option included inactive providers in eDex. This has been fixed.

•	 When you enabled passwords in Dentrix, new Office Journal entries did not default to the correct 
user when you opened the Office Journal from Auto Dial in the Appointment Book. This has been 
fixed. 

•	 Customers using an Ingenico 6550 or 6580 device with PowerPay were unable to use it as a signature 
device in the Dentrix Treatment Planner and Questionnaires modules. These devices are now 
supported in the Dentrix Treatment Planner and Questionnaires modules. 

•	 In Dentrix G6, if you defined different printers for the Patient Chart and the Office Manager, the 
Patient Chart printed to the Office Manager printer. This has been fixed, and the Patient Chart now 
prints to the correct printer. 

•	 The Copy to Clipboard toolbar button in Patient Picture did not always copy the Patient Picture 
image to the Windows Clipboard. This has been fixed. 

•	 After you set an appointment complete in the Appointment Book, if you updated the fees in the 
Office Manager’s Fee Schedule and then re-opened the Appointment Book to view the completed 
appointment information, the updated fees appeared. Once you set an appointment complete, the 
fees should not update. This has been fixed, and fees for appointments set complete will not change 
when you update the Fee Schedule. 

•	 In the Patient Chart and the Treatment Planner, some print options and procedure information were 
not saved after exiting. This has been fixed. 

•	 If you enabled passwords in Dentrix, then closed Dentrix without closing a link program, such as 
DentriXlink, and then re-opened Dentrix, you were not prompted for a password. This has been fixed. 

•	 When you perform a search in Select Patient, the entire list of items you are searching for appears 
in the list, and Dentrix selects the closest match to your search parameters. For instance, if you are 
searching for patients by their last names and type “C,” Dentrix shows the entire patient list but 
selects the first patient whose last name begins with the letter “C.” 

•	 VoicePro 5.0 had a conflict with Quick Letters in Microsoft Windows 7. If you had VoicePro open and 
then tried to merge letters using Quick Letters, the merge time increased substantially. This has been 
fixed. 

•	 If you set an Auto Punch Out Time of 7:00 p.m. in the Dentrix Time Clock, the 7:00 p.m. time would 
not be saved after closing the Time Clock. If you set a time after 8:00 p.m., the Time Clock would save 
a different time. This has been fixed.
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Dentrix G6 Canada Known Issues
Dentrix G6 Canada contains the following known issues:

•	 When performing a letter merge, if you select a simple merge code, such as <<First Name>> and 
then double-click Last Name, the <<LName>> code overwrites <<First Name>>. However, if you 
select <<LName>> and then double-click Salutation (conditional), a complex merge field, it inserts 
<<Salutation>> after the selected merge code rather than replacing it. 

How to Learn More about Dentrix Releases
For more information on how to use the new features in this release, refer to the Dentrix Help. For 
information about new features and enhancements in previous Dentrix releases, see “What’s New in 
Dentrix?” in the Dentrix Help.

To find essential Dentrix learning resources for your entire dental office team, visit the Dentrix Resource 
Center. New team members can learn Dentrix basics with on-demand tutorials. Experienced staff can 
enhance their knowledge of Dentrix with webinars, user’s guides, and searchable knowledgebase articles. 
These resources are free with your Dentrix Customer Service Plan. Log in today at www.dentrix.com/
resource-center.


